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About This Guide

The Qlik Health Service nKPI1 & OSR Report user guide has been developed for those users

within health services who will use the Qlik Health Service nKPI & OSR Report to monitor how

their health serviceb s a g g r e gand @SR datadsRrending over time. These reports can

also be used by health service users to compare their data to their own self-determined targets,

national averages, and applicable comparison groups they can create themselves, comprising

the health servicestheywoul d | i ke t o compare their serviceobs

This guide will take users through how to interpret the different interactive Indigenous health
data sheets within their Qlik report, as well as how to manipulate the data in the sheets by
performing functions such as filtering, creating stories and exporting data into different formats
as required.

¥ 10 access the Qlik Health Service nKPI & OSR Report for your health service, you will need
to be given the Interactive Report Viewer role for your health service in the Data Portal by your
Health Data Portal User Administrator.
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Version History

This section details the different versions of this user guide and what they contain, allowing you
to decide if/when you need to download an updated version of the guide for your use.

Version Number Date Change
1.0 1 November 2023 | Original version
1.1 26 March 2024 Updating references to the report name
1.2 13 September 2024 | Updated to include new sheets
1.3 21 March 2025 Updated to incorporate enhancements
1.4 1 April 2025 Updates to reflect enhanced published reports
15 10 September 2025 | Updated to reflect new Departmental branding
1.6 26 March 2026 Updated to include new functionality in Exec
Summary sheet and updated screenshots
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The Qlik Health Service nKPI & OSR Report

As part of the implementation of the Health Data Portal as the tool used by health services to
report on Indigenous Health-related data, a reporting tool known as Qlik has been introduced
into the process.

The Qlik Health Service nKPI & OSR Report gives health services the ability to see their
reporting data in a flexible and graphical format. The report allows health service users to see
their reporting data in the context of national averages as well as against self-determined
targets and their own comparison groups. It also gives users the ability to filter their data so they
can compare their results on a particular indicator to those of other health services of similar
size and characteristics, for example.

Another benefit of the report is that it provides users with access to data in a timely manner.
With the introduction of Qlik, consumers of Indigenous health reporting data can now access
their data through their Qlik report almost immediately after a data asset has been submitted in
the Health Data Portal by the health service.

@ nKPI data from December 2014 and OSR data from 2016 onwards will be available in the
Qlik Health Service nKPI & OSR Report. This was when funding agreements were changed to
allow the Department of Health and Aged Care to access health service data.
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Get Started with the Qlik Health Service nKPI & OSR Report

The Health Data Portal is integrated with the Qlik reporting tool, which provides access to online
interactive reports (such as the Indigenous health data reports) allowing you to view trends and

patterns in your data and compare it with other data sets as needed. Access to Qlik is available

directly through the Data Portal, providing you have the required access.

When health services submit data assets in the Data Portal, the contents of these data assets
are used to view and manipulate different interactive sheets in their Qlik Health Service nKPI &
OSR Report.

Access the Qlik Health Service nKPI & OSR Report

The following procedure is used to access the Qlik Health Service nKPI & OSR Report.
1. Navigate to the Data Portal home screen.

2. To open Qlik, select Reports > Interactive Reports  from the menu bar.

@ To be able to access Qlik, you must have been given the Interactive Report Viewer role by
your Data Portal User Administrator.

The Qlik Sense interface screen will display.

ﬂ v New ~ Reports & Reporting Dashboard

= QIikQ Sense® Enterprise Q @

Streams v Indigenous Health 1= | Name v B =]

Consumption

Indigenous Health ‘ C vl D.]g
Indigenous Health Int... ACCl

RAS
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559 | 5

AIR - COVID De-

entified Indigenous

R
D&

=
S
7y -
%

7
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3. To continue, select Indigenous Health under Streams on the left-hand side of the
screen.

4.  To access the Health Service nKPI & OSR Report within Qlik, select the Health Service
nKPIl & OSR Report app on the right-hand side of the screen.
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The Health Service nKPI & OSR Report screen will display.

2 sheets [ Bookmarks &) stories

¥ Public sheets (39)

@ ILII ILII IMI ILII ILII

1>1z

‘‘‘‘‘‘

The Health Service nKPI & OSR Report screen is the screen used to launch each interactive
0 s h eThis sBreen contains at least one 6 s h déoeeadh of the applicable nKPI& plus three
summary sheets, one for Maternal and Child Health, one for Preventative Health and one for
Chronic Disease Management. It also contains a Health Service Snapshot, a Summary over
Time sheet, an OSR Summary Over Time sheet, an Executive Summary sheet, a Closing the
Gap Target #2 sheet, and a National Trajectories sheet.

To launch a particular sheet, simply select the top half of the tile for that sheet.

Work with the Components of a Sheet

After selecting a particular sheet in the report, you can view the associated Indigenous health
data results in different, graphical formats.

PI02: Birthweight result
il Tral Submisss K definitions and cha...

Maternal and Child Health e r—

Outcomes

Collection Menth PI82: Birthweight result 1 visit
it weist H H I I H I
] =

P162: Birthweight result » 1 visit comparison

(% Comparison Group data ...

Comparison Group Limiter

ompariso
4868 Remoteness Don't Display

MMM Remotaness To be displayed the comparison group must have more than 5 organisations and a single birth weight result must be selected. Top 5%

Top 25

As the above example shows, Indigenous Health data in QIlik is presented primarily using bar
charts, although there are other ways the data in can be presented.

In addition to the results for the selected sheet, each sheet contains a:

 Menu Bar
M Selections Bar, and
M Title Bar
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Menu Bar

| alik@ -~ 5 s Stakeholder kP! . 05R Repart - |

The Menu Bar in each sheet provides access to the following functions:

1 Select ... to export the selected sheet to PDF, access Qlik help, learn more about the
software or navigate back to the Health Service nKPI & OSR Report screen from a
particular sheet.

1 Select o Jto return to the 6sheetsod view if
view,
1 Select serelne | to view the Indigenous health data stories you have created or to

create a new story. Stories are slide show presentations that contain extracted data
from the reports you have access to, as well as other data that can be uploaded into
the story.

q  Lskenodernkpia osrreport v | ghoyys the title of the report you are currently using. Selecting
v provides more information regarding the report.

1 | © | allows you to ask Qlik questions about the data contain with the
report, using natural language.

Selections Bar

|m et A ‘ A B o | [ coomans v |3 s v < >|

The Selections Bar is located directly beneath the Menu Bar and allows you to filter the results
that are showing for a particular sheet by selecting specific criteria to filter the results by.

1 Select to access the Insight Advisor, which helps you build your data
model, create visualisations and analyse your data.

1 Select and enter in key words to search within the entirety of your Indigenous
health data.

91 Select and I:I to move forward and back between the various data parameters
you have selected once selections have been made.
Select to clear any data selections/filters you have made.

If you have filtered your data by either using the filter fields at the top of a sheet or by
selecting a particular parameter on one of the graphs in the sheet, the selection (s) will

display on the left-hand side of the Selections Bar
1 Select to select the criteria you wish to filter the results for. For example, if you are

viewing the results for the number of fully immunised indigenous children across the
country, you can filter the results by a particular age group if needed.

m Bookmarks v . .
1 Select to bookmark and save the location of a particular sheet or a
comparison group you have created, and reuse or access these previously saved
bookmarks.

 Select [ presomiere.. @+ (1 view a drop-down window displaying the different sheets in
the Health Service nKPI & OSR Report and to switch between sheets as needed. The
name on the button will identify the sheet you are currently viewing.

1 Select to move forward and back between sheets in the order they display
on the Health Service nKPI & OSR Report screen.
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The Title Bar

PI13: First antenatal care visit ‘

The Title Bar will display the name of the sheet currently being viewed.

The Hover Menu

PI81: Birthweight recorded >1 visit

(65/66) 98%

Data for collection Jun 282 4- To equal the Dec 2623 comparison group average for the selected result you would need 2 more regular client(s) in your result

(56/57)98%

B My Service
Comparison Group
# Top x% (not displayed)

When you hover your mouse pointer over a graph on a particular sheet, a hover menu will
appear presenting you with some options regarding what you can do with the data in the

selected sheet.

@ Full Screen 1 Allows you to expand the selected graph to full screen view so the results
can be analysed more easily.

()

""" More i Takes you to a menu from where you can take data snapshots, access the
exploration menu to change the view of the graph and export the graph and its data out of Qlik,

amongst other things.

vl.5
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The Shortcut Menu

In addition to the hover menu, the shortcut menu also allows you to perform functions within a
sheet. The shortcut menu is activated by right clicking on the selected graph.

“| - Allows you to expand the selected graph to full screen view so the results can be
analysed more easily.

- Allows you to quickly change the properties of the results you are viewing. For
more information, see Use the Exploration Menu later in this guide.

B Viewdata| Changes the selected graph into a table and displays the data included in the
graph in a tabular format.

- Allows you to embed the graph into a webpage by selecting the arrow and then Embed.

—| - Takes you to:

|@] Open snapshot library |

- Opens a list of all snapshots you have taken in the sheet so you can
add them to your data presentation if needed.

| [E§ Take snapshot |

- Allows you to take a snapshot of the data that can then be used in a
presentation you may wish to give about your data. For more information, see 7ake a
Snapshotlater in this guide.

- Image - Allows you to export the selected graph as an image so it can be
downloaded and saved as required.

PDF - Allows you to export the selected graph as a PDF document.
Data - Allows you to export the contents of the selected graph into an Excel spreadsheet.
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Filter Sheet Data

Maternal and Child Health Show 2 Dec 2020 | Showssuzas | include Trial Submissions Exclude Trial Submissions ©) kPl definitions and cha...

Process of Care

Coliection Month

PI81 Compar. Orgs - Dec 2023

Comparison Group Limiter

As you are interpreting the data in each of your Qlik sheets, you may wish to filter the data to
focus on certain information. For example, you may wish to simply compare your results for the
current collection period to your results for the previous period.

Any filtering/selections you apply to the data for a particular sheet will be reflected on the
Selections Bar at the top of the screen. You can then manage your selections as required using
the Selections Bar.

There are several ways you can filter/select data in a report when working in the Qlik Health
Service nKPIl & OSR Report:

1 Make selections on a graph
1 Use the Selections Tool
1 Use the Filter Pane.

Make Selection s/Filter Data on a Graph

When working with graphs in a particular sheet, you can quickly and easily select a particular
data characteristic to filter the sheet by, using different selection options.

The following procedure is used to filter data by making selections on a graph.
1.  Select the sheet you wish to apply your filter to.
The selected sheet will display.

PI01: Birthweight recorded
ho Include Trial Submissions

Maternal and Child Health
Process of Care

Exclude Trial Submissions ©) nKP| definitions and cha...

Collection Month

PI61 Compar. Orgs - Dec 2623

Comparison Group Comparison Group Limiter

Tops %

ASGS Remotenes:

The different options when filtering graphs using selections are:

9 Clicking - Simply click on the area of the graph you wish to filter by. For example, you
may wish to click on a particular bar in the graph to filter the report to display only
results for a particular collection period/month.
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9 Drawing i Click on the area of the graph to be filtered and then use # to draw the
lasso around the different areas of the graph to be included in your selection.

1 Using Labels - Click the applicable label on the axis and the graph will be filtered by
the group of data associated with the label.

9 Using Ranges - Draw over a range on either the x or y axes to filter by a specific data
range.

To filter data/ select by clicking:
i. Click on the portion of the graph (e.g., Dec 2018) you wish to filter by.

The report will update to show the Selection window for the selected graph.

P E X v
PIe1: Birthweight recorded >1 visit

Data for collection Jun 2824 does not have a comparison equivalent

1

(65/66) 98% (56/57) 98%

ii. To confirm the selection and apply it to all graphs for the report, select .
The sheet has now updated to be filtered by the data group(s) selected.

PIO1: Birthweight recorded =1 visit

Data for collection Jun 2824 does not have a comparison equivalent.

8.8
(4B/65) 74%

8.6

84

Jun 2824
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To filter data/ select by drawing :

i. Click on the portion of the graph (e.g., Dec 2018) you wish to filter by.
The graph will update to show the Selection window for the selected graph.

£ E X v
PI@1: Birthweight recorded >1 visit
Data for collection Jun 2624 does not have a comparison equivalent.

1

(65/66) 98% (56/57)98%

ii. To activate the drawing tool, select 2,

iii. Draw around the data group(s) to be included in your selection/filter.

623 comparison group average for the selected result you would need 2 more regular client(s) in your result

(46/53) 87%

(56/67) B4%

{38749) 78X

(48/65) 74%

The Selection window has now been updated based on the data you have drawn around
using =4

iv. To confirm the selection and apply it to all graphs for the report, select .
The graph has now updated to be filtered by the data group(s) selected.
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To filter data/ select by using labels :
i. Click on the axis label (e.g., Dec 2024) you wish to filter by.
The sheet will update to show the Selection window for the selected graph.

£ E X v
PI@1: Birthweight recorded >1 visit
Data for collection Jun 2624 does not have a comparison equivalent.

1

(65/66) 98% (56/57) 98%

(46/53) 87%
(53/62) 85% (56/67)84%
68 (38/49) 78%
(48/65) 74%

Dec 2821 Jun 2822 Dec 2822 Jun 2823 Dec 2623 Jun 2024

ii. To confirm the selection, select .

The graph has now updated to be filtered by the data group(s) selected.
To filter data/ select by using ranges :

i. On a particular axis, draw over the range you wish to filter the graph by.

The graph will update to show the Selection window for the selected graph.

[sun 2024

(56/57) 98% Dec 2023

(46/53) 87%
(56/67) B4

{3849)78%
(48/65) 74%

Jun 2622 Dec 2622 Jun 2823 Dec 2623

Jun 2824

i. To confirm the selection, select .
The graph has now updated to be filtered by the data group(s) selected.
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Use the Selections Tool

When filtering data, the Selections button on the Selections Bar allows you to make
multiple data selections across the entire suite of sheets in the Qlik Health Service nKPI & OSR
Report rather than making individual selections in different graphs for different sheets. The
Selections Tool view will show all the filter options available for the report.

The Selections button is located on the far right-hand side of the Selections Bar.

The following procedure is used to make data selections in the Qlik Health Service nKPI & OSR
Report using the Selections button.

1. Select a sheet from the Health Service nKPI & OSR Report screen.

The selected sheet will display, and the Selections Bar will be available at the top of the sheet.

P102: Birthweight result

Cal " P182: Birthweight result =1 visit My Service data export

PI82: Birthweight result > 1 visit comparison

ompariss i imits
505 Remateness Doa't Display

/ 5 7 it A Top5 %
MMM Remateness f the ar up must have more than 5 organisations and a single birth weight resu t be selectec

Sarvice Sizs

2. To continue, select on the Selections Bar.

The Selections screen will display.

’Ei‘
EEE

Mo selections applied

uuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuuu

The Selections screen contains two sections:

1 Selections (in default state) i Displays any active selections/filters that may have
been made by filtering data using one of the methods detailed above.

1 App Dimensions i Displays all selections available to filter by. When the Show fields
check box is selected, all fields available across the different sheets will be shown.

3. To continue, select the required option in the APP DIMENSIONS section.
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The selected dimension box will update with the selection highlighted in green.

App « B
e X v

Age Group P184

12-24MTH «

24-36MTH

68-72MTH

In addition to the Selected value being highlighted in green, any Alternative values (that could
also have been selected) will be light grey. Any values that are Excluded (not available to be
selected) will be shown as dark grey.

4.  To confirm the selection you have made, select .

@ 10 access the Selection menu , Select «=+. From here you can cancel your selection, select
alternate or excluded values or select all available options in the dimension.

@ 1o cancel your selection, select E

The selection will now be moved up into the SELECTIONS section of the screen. The colours of
the values in the APP DIMENSIONS section of the screen may now change depending on the
impact the selected value will have.

In the screen shot below for example, selecting No in the Age 25 yrs + dimension has updated
the other dimensions in the APP DIMENSIONS section, so some are still possible to select
while others arené6ét because of what has already

Selections (in default state) @ Explore selections

Age Group PT84
12-24MTH -
24-36MTH

5. Repeat steps 3 and 4 for each selection to be made.

& 1o clear a selection once it has been added to the SELECTIONS section, select [E in the
top left-hand corner of the selection to be cleared.

6. To close the Selection Tool and return to the sheets with the selected filters applied,

select .

The selected sheet will display with all selected filters applied and visible on the Filter Menu.
The filter will now also be applied to any other sheet you select in the Health Service nKPI
Report.
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@ You can clear your filters from here by selecting on the Selections Bar.

Use the Filter Section

Another way to make selections/filter data when working with a sheet in the Health Service nKPI
Report is through the Filter section that is in the top half of the sheet, underneath the blue Title
Bar.

Using the Filter section allows you to build your selections whilst being able to see the impact
your selections are having on the graphs on your selected sheet.

The following procedure is used to make data selections using the Filter section.
1. Select a particular sheet from the Health Service nKPI Report screen.
The selected sheet will display, and the Filter section will be available for use as required.

PI02: Birthweight result

Maternal and Child Health Showspeczom T porCr— Py E—
Outcomes
ecton N PI82: Birthweight result » S

1 visit
Birth Weight
& L]

PI82: Birthweight result » 1 visit comparison 2 Comparison Group dats

arison Grou Comparison Group Limiter
A5GS Remoteness Don't Display

MMM Remotaness To be displayed the comparison group must have mare than 5 organisations and a single birth wei

service size

2.  To commence filtering/making your selections, select the applicable filter option from the
Filter section, as highlighted above in red.

The Selection window will display.

CollectionM... == '@ X

Ql

Jun 2624

3. Make the required selection from the list that displays.

You will notice the graphs on the sheet updating in the background once you have made your
selection.

4, To confirm the selection you have made, select .

@ To access the Selection menu , select ==+. From here you can cancel your selection, select
alternate or excluded values or select all available options in the dimension.

@ To cancel your selection, select E
The selected filter field will now update to show a selection has been made.
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5. Repeat steps 1 to 3 for each selection to be made.

Collection

@ To clear your selections, select on the Selections Bar.

Page 20 of 121
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Save Comparison Groups for Future Use

When working with sheets in your Qlik Health Service nKPI & OSR Report you may wish to
compare your data against that of other health services with similar characteristics (such as
size, state, and remoteness) i this is known in Qlik as a comparison group.

To create your comparison group in your report, you would first select the required components
of your new comparison group. For more information on how to do this, see Filter Sheet Data
earlier in this guide.

When you close the Qlik Health Service nKPI & OSR Report, you lose any comparison groups
you have created and would then need to create them again the next time you open the report
and wish to compare your data against the same comparison group.

To avoid this, you can use the bookmark functionality in Qlik to save the comparison group you
create so it can be quickly and easily reapplied each time you need it.

The following procedure is used to save a comparison group for future use.

1. Inan applicable sheet in the Qlik Health Service nKPI & OSR Report, select the filter
options required to form your comparison group.

P101: Birthweight recorded

Maternal and Child Health
Process of Care

Collection Month

PI61 Compar. Orgs - Dec 2023

Comparison Group

ASGS Remoteness
MMM Remoteness
Service Size

w

2. Once you have built your comparison group, from the Menu Bar at the top of the sheet,

and SeleCt | Create new bookmark |

u Bookmarks ¥

select
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The Bookmarks window will display, and the title of the bookmark will default as Bookmark.

Create bookmark X

) ssvechest location

save layout

3. Update the title of the bookmark/comparison group in the Title field as needed.

4, Enter a description for the new comparison group in the Description field.

5. To save the bookmark, select .

To save the comparison group, click anywhere off the Bookmarks window.

The comparison group has now been saved. Note that you can save bookmarks for any number

of combinations of filters, allowing you to switch between different comparison groups.

Select the Bookmark to Reapply Your  Comparison Group

Once you have created a bookmark to save your comparison group, you can then reapply your

comparison group to any sheet within Qlik by selecting the bookmark.

1. From any sheet in the Qlik Health Service nKPI & OSR Report, select mi and locate
the applicable bookmark in the list that displays.

2. Right click on the bookmark and select Apply selections .

The comparison group contained within the bookmark will now be added to the Filter Bar and
the values on the selected sheet will update based on the comparison group that has been
applied.
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Work with Snapshots

When working with graphs within the Qlik Health Service nKPI & OSR Report to analyse your
data, you can take snapshots of your data to collect any insights you have as you go. A
snapshot is a graphical representation of data at a point in time that you can then use when you
build stories within Qlik, which are like PowerPoint presentations you can use to present your
data to others in a graphical, engaging way.

Any data snapshots you take can be enhanced with various effects to let you emphasise the
data insights you want your audience to focus on whilst presenting a story.

All the snapshots you take are stored in a shapshot library, which you can easily access to
decide which snapshots you would like to keep and use in your stories. From there, you can
also add descriptions of your snapshots and

Take a Snapshot

From the applicable sheet, you can take shapshots of your data and use them to build a story
for easy presentation of your data.

1. In the applicable sheet, navigate to the graph you wish to take a snapshot of.

Pl01: Birthweight recorded

Maternal and Child Health Show = Dec2020 | Showzhwza | Include Tria Submissions [ fctude rintsubmissions | WP definitions and ch...

Process of Care

Callection Month PIB1: Birthweight recorded >1 v

Comparison Group Limiter

Don't Display
5%

N
2.  To take your snapshot, either hover your mouse pointer over the graph and select " and
then Storytelling snapshots > Take snhapshot  right click on the graph and select
Storytelling snapshots > Take snapshot

The Snapshot annotation window will display.

Snapshot annotation

Cancel Save

3. Enter a description of the snapshot so you can easily identify it.

4.  To save the snapshot, select .

The snapshot is taken and added to the snapshot library for you to access as needed when
building your story.
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Edit a Snapshot

Once you have taken a snapshot, you can add a description to the snapshot or remove the
shapshot if required, through the snapshot library.

1. Inthe applicable sheet, right click anywhere on the sheet and select Storytelling
snapshots > S napshot library .

The Snapshot library window will display.

Snapshot library

¥ Older

A PI01: Birthweigh. ..
‘II March 29, 2021

A PI01: Birthweigh_.. cOMPARISON TO TOP 25

lll November 252020 PERCENT OF THE STATE

A PI01: Birthweigh... ALL nsw SERVICES WITH O gps
al

'\.

The Snapshot library window will display all the snapshots taken for the selected sheet.

To add a description (annotation) to a snapshot:

i. Inthe Snapshot library window, select .
ii. Inthe text box that appears to right of the snapshot, enter the description.

iii. To save the description, select again.
The description has now been saved.

To delete a snapshot:

i. Inthe Snapshot library window, select .
ii. Selectthe check box that appears to the left of the snapshot.

iii. To delete the snapshot, select Ij
The snapshot has now been deleted.
2. To close the Snapshot library window, click anywhere on the sheet, away from the window
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Use the Exploration Menu
Within Qlik, you can change the display of a graph and conduct further data analysis without
having to make selections on the sheet. This is done by using the Exploration menu @

The Exploration menu allows you to change and sort data and change how labels are
displayed.

The following procedure is used to analyse data and change the view of data in Qlik using the
Exploration menu.

1. Hover your mouse pointer over the graph you would like to analyse/work with.
N
2. Select \" and then select Exploration menu .
@This can also be done by right clicking on the graph and selecting Exploration menu.

The selected graph will now display in full screen mode with the Exploration menu activated on
the right-hand side of the screen.

PI13: First antenatal care visit

PI13: First antenatal care visit

7% 0% 6%
ax e £ -
- s = —
2

- zsz .
- - - - - - - -
Dec 2014 May 2815 Jun 2616 Jun 2817 Dec 2817 Jun 2018 {D}Oct 2018 Dec 2018 May 2819 (D) Jul 2819
(D) indicates @ droft eubmission, (T) indicates o trial submissio

The Exploration menu contains four sections you can use to analyse the data on the selected
graph:

Data (will default as selected)
Sorting

Presentation

= =4 =4

Colors and legend
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The Data Section

E Data

Dimensions

Calendar Month

Gestational Age

When you have more than one dimension (what the data is being measured by, e.g., state or
collection month) or measure (what is being measured, e.g., immunisations) available in a
graph, you can use the Exploration menu to change the data that is used in the graph.

1. To change how the data is being displayed in the graph, select E next to the
Dimension you wish the data to be displayed by.

2. Hold the left mouse button down and drag up so the selected dimension is on top of
the Dimensions section.
3.  To see the display of the graph change, release the mouse button.

The way the data in the graph displays has now changed. In the example below, the PI113 First
antenatal care visit graph is now showing the gestational age as the primary dimension rather
than the collection month.

PI13: First antenatal care visit
PI13:First antenatal care visit [0] ui 0

M Dec2014

W May2015
Jun 2816

W Jun2e17

M Dec 2017

M Jun 2018

M (D)Oct 2018

M Dec2018

B May2619

M (D)Aug 2019
(T) Apr 2020

W (1) May 2020
W (D) Jui 2019

My Service

160%

(D)indicates a draft submission, (T) indicates a trial submission

4.  To close the Exploration menu with the changes applied, select 9
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The Sorting Section

J= Sorting

» Calendar Month

» Gestational Age

» My Service

The Sorting section of the Exploration menu allows you to determine the order in which the data
is sorted in the graph. This can be done by changing the order of the dimensions and measures
and changing whether the data is sorted in ascending or descending order.

1. To change how the data is being sorted in the graph, select E next to the value you
wish the data to be sorted by.

2. Hold the left mouse button down and drag IEI up so the selected value is at the top of
the list.
3.  To see the data sorting order change, release the mouse button.

4.  To change the sort order within each value, select [] for the applicable value and then
select either Ascending or Descending as needed.

The way the data in the graph is sorted has now changed. In the example below, the PI13: First
antenatal care visit graph is now sorted with 13 to 19 weeks at the bottom of the graph, followed
by 20 weeks or later etc.

PI13: First antenatal care visit

Jun 2882

(D) Nov 2619

8 2019
(D) ndicotes o droft submission, (T} indicates o trial subrmission

5.  To close the Exploration menu with the changes applied, select 9
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The Presentation Section
g Data

1= sorting

4P Presentation

Value labels
orf -

il N

Grouped Stacked

Vertical Horizontal

The Presentation section of the Exploration menu allows you to add labels to the individual
values in the graph and change the way the values are displayed (vertical v horizontal, grouped
v stacked).

1.  To turn the value labels on, select -I to the right of D .

The value labels have now been switched on.

2.  To change the way the values are displayed, select the required view (grouped or
stacked, vertical or horizontal).

The graph has now been updated to include field labels and the changed data view.

PI13: First antenatal care visit

PI13: First antenatal care visit Lo I 1 B ]

Dec2614 n ax W Berore 13 weeks

W 13019 weeks

20 weeks or later

Timing not
recorded

Jun 2616

M Did not attend visit

Jun 2617 [EEES

Dec2617

Jun2618

(D) Oct 2818

Dec2618

May 2619

(D) Jul 2019

(D) Aug 2619 [EEETS

(herzeze o o
(O¥ar2ezs o o

My Service

(D) indicates a draft submission, (T) indicates a trial submission

3.  To close the Exploration menu with the changes applied, select 9
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The Colors and legend Section

| & Colorsand legend

. Auto

Single color
By dimension

By measure

The Colors and legend section of the Exploration menu allows you to change the colours of the
bars displayed in the selected graph. You can change all the bars to a single colour or change
the dimensions or measures to a particular colour scheme.

1. To change the colour of the bars on the selected graph, select . next to the applicable
option.

2. If selecting either By dimension or By measure , you can select the required colour
scheme.

3.  To close the Exploration menu with the changes applied, select 9
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Export Data from Qlik

One of the features of Qlik is that you can quickly and easily export your graphs and data tables
out of Qlik into several different formats, depending on what you would like to do. Some of the
export options you have in Qlik are:

1 Export a graph as an image
1 Export a graph as a PDF document

1 Export data to an Excel spreadsheet.

Export a Graph as an Image
1. Right click on the graph that you wish to export as an image.
2.  Select Download as > Image.

The Image settings window will display.

Image settings
B7E x 394 .

Type of file

Png

Cancel Export

3. To change the settings of the image, select .

The Image settings window will update to allow the image settings to be updated.

Image settings

Width (pixels)
Height (pixels)

Resolution (dots perinch)

96 +

Type of file

Png ¥

Cancel Export

4.  To change the width of the image, select |:| or III in the Width (pixels) field.
5.  To change the height of the image, select |:| or in the Height (pixels) field.

6.  To change the resolution of the image, select |:| or in the Resolution (dots per
inch) field.
The file type will default to Png.

7.  To change the type of file the graph is exported as, select = in the Type of file field and
select Jpeg if needed.
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8.  To export the graph, select m

The Click here to download your image file link will display at the bottom of the Image
settings window.

9. To commence downloading the image, select Click here to download your image file.
A pop up will display in the bottom left-hand corner of the screen.

B B840775204d24507 _.png A~

10. To download the image, select # and select Open.
The image will now display as the selected file type.

11. To save the image, select é > Save as from the top right-hand corner of the screen.
The Save As window will display.

Save As X
+ » UCDV-C2SD1-0644 > Desktop > Captivate v |0 Search Captivate pel

Organise ¥ New folder =~ @

Health Data Port »  Name Date modified Type Size

Timesheets IHDR

AM  File folder
6 PM  File folder

3.. Filefolder

[ UCDV-C25D1-064 NDSSE
Portal

[ Desktop

[£ Documents

4 Downloads

D Music

&] Pictures

B Videos

= ServerApps (\ce

= Dunnst (\\centrz

Saveastype: | PNG v

~ Hide Folders Cancel

12. Select the location to save the image and enter the title of the image in the File name
field.

13. To save the image, select .

The selected graph has now been exported and saved as an image.
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Export Data as a PDF Document
1. Right click on the graph you wish to export to a PDF document.
2.  Select Download as > PDF.

The PDF settings window will display.

PDF settings

Paper size

A4(117°x8.2757) ¥

Resolution (dots perinch)

208 +

Orientation

Aspect ratio options
Keep current size

Fit to page

Cancel Export

3. To change the size of the PDF document, select = in the Paper size field and select the
applicable paper size from the list that displays.

4.  To change the resolution of the image in the PDF document, select |:| or III in the
Resolution (dots per inch) field as needed.

5. To change the orientation of the PDF document, select either or as
needed.

6. Under Aspect ratio options , leave Keep current size selected to insert the graph into
the PDF without changing its size or select Fit to page to change the height and width of
the graph to fill the entire page.

7. To export the graph, select m

The Click here to download your PDF file link will display at the bottom of the PDF settings
window.

8.  To commence downloading the PDF, select Click here to download your  PDF file.
A pop up will display in the bottom left-hand corner of the screen.

" 1557c643d5ch41148...p... A

9. To continue, select # and select Open.
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The PDF document will now display.

E e

File Edit View Window Help

Home Tools afd21e59deb1463... X

B ¥ B8 20 Q ®

PI13: First antenatal care visit

153%

ieaz] Lol [ieer w 3wis
vieeka
f I I I I =
recorded
© O @
@ei \1&* @\;' o
(D) inchcates a draft sebmicsion, {T) indicates o ticl submiasion
10. To save the PDF document, select B
The Save As window will display.
@ savens X
4~ B8 > UCLPBDGLMS3 » Desktop v | & Search Desktop o
Organize » Mew folder Bz -
User Guides Ca) Name . Status Date modified Type
Videos
Mo items match your search.
WINDOWS
W UCLPBDGLM33
I Desktop
& Documents
4 Downloads
B Music
&= Pictures
B videos
29 Windows (C:)
=~ ServerApps (Ve
& Netwnr &4 e
ST Rl cf0edd2f204edc35aba2e0d 1 d41207bd.pdf] "
Save as type: | Adobe Acrobat Document (*.pdf) ~
A Hide Folders | Save | \ Cancel |

11.
File name field.

12. To save the image, select .

The selected graph has now been exported and saved as a PDF document.

Select the location to save the PDF document and enter the title of the document in the

vl.5
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Export Data to an Excel Spreadsheet
1.  Right click on the graph containing the data to be exported to Excel.
2.  Select Download as > Data.

The Export complete window will display.

Export complete

Your exported data is ready for download.

Click here to download your data file.

Close

3. To commence downloading the Excel file, select Click here to download your data file.
A pop up will display in the bottom left-hand corner of the screen.

] 950d9c04-0bf0-499_xlsx A~

4, To continue, select # and select Open.
An Excel spreadsheet containing the exported data will display.

@ Autosave (@ o) D~ = deade7f1-b232-4729-b4eb-d6cb564
Filee Home |Insert Draw Pagelayout Formulas Data Review
Ii—\"j X |calibri V”11 V‘ = = E] 25 |General
~ - VA =EE=E ~ 9
Paste @™ B I U A A = = = $ %
v v v A = 3= . <0 0
Clipboard 5 Font 5 Alignment 5 Number
G13 v fr
A B © D
1 Calendar Month My Service Comparison Grouf Top x% (not displa
2 Jun 2021 (5467/6960) 79% 79% -
3 Dec2021 (6012/7874) 76% 76% -
4 Jun 2022 (5764/7531) 77% 77% -
5 Dec2022 (5674/7477) 76% 76% -
6 Jun 2023 (5853/7557) 77% 77% -
7 Dec2023 (5838/7617) 77% 77% -
8 Jun 2024 (5952/7685) 77% 77% -
9

5.  To save the Excel spreadsheet, select File > Save As .

Page 34 of 121 v1l.5



The Qlik Health Service nKPI & OSR Report The QLIK Health Service nKPI & OSR Report User Guide

The Save As window will display.

£l Save A

1 & > This PC » Windows (C) > Users > DunnstCENTRAL > Downloads

e ServerApps (e - Earlier this week (1)

@ Network v B PHC+I&E+Template+-+2023-24 (1)xsx

[FERE T C R deadef1-b232-4729-bdeb-dbch 5

Organize = New folder
WINDOWS A Name Date modified
= This C Today (2)
I Desktop 5] deade7i1-b232-4729-bdeb-d6cbS6424e..  5/12/2024 10:43 AM
4 Documents &) PHC+I&E+Template+-+2023-24 (2)xdsx  5/12/2024 1025 AM
¥ Downloads - Yesterday (4)
& Music BY 2872407¢-756¢-4cde-9454-c41aded3aca..  4/12/202¢
&= Pictures B eb60523b-7320-4fa0-aac5-dc3849b574
8 videos {8 565585e-SeclS-4aSa-bad1-5470a666b..
5 Windows (C B 9acBeb55-8c39-4122-a580-91388c953c .

Type

Save as type: Excel Workbook (*xlsx)

Authors:  DUNN, Stuart Tags: Add a tag

[~] Save Thumbnail

2 Hide Foldor.

Title:  Add a title

Gook v [ sove |

Cancel

6.  Select the location to save the Excel spreadsheet and enter the title of the document in

the File name field.

7. To save the spreadsheet, select .

The data from the selected graph has now been exported and saved in an Excel spreadsheet.
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Smart Search

Smart Search is the global search tool in Qlik that allows you to search the entire data set in the
Health Service nKPI & OSR Report for a particular characteristic. You can then select this
characteristic and apply it as a filter to the currently selected sheet in your report.

Smart Search is activated by selecting on the Selections Bar in the top left-hand corner of
the screen.
The following procedure is used to run a search in Qlik using Smart Search.

1. To activate smart search, select on the Selections Bar in the top left-hand corner of
the screen.

The search field will be activated.

2. In the Search your data field, enter the data value you are searching for.

A list of values for your search will display.
Q d=

ACR Accepted Al and Australia Aboriginal Aged ACT AC-1a-1

Service Name

Albury Wodonga Aboriginal Health Service Incorporated
Sub Module

Accreditation

State

MSW & ACT

Gestational Age Desc

Did not attend wvisit

Module
Community Engagement, Control and Cultural Safety

3.  Select the value you wish to filter the currently selected sheet by.

The sheet you currently have selected will now be filtered by the selected value and the
selected value will now be added as an applied filter to the Filter Bar.
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Work with Bookmarks

When analysing data in a graph, you may find something interesting you would like to return to
or share with others. Using bookmarks is a way to easily keep track of a certain selection on a
particular sheet.

Bookmarks can be used to save selections and particular locations. A bookmark can be opened
at any time to restore the selections to a former state. When you use a bookmark, you can apply
its selections or apply selections and go to the sheet you were exploring when you created the
bookmark.

@ Bookmark functionality can also be used to save filter selections so they can be reapplied.

Create a Bookmark

1.  Onthe applicable sheet, select the graph or apply the filters you wish to create as a
bookmark.

m Bookmarks v

2. On the Menu Bar, select

The Bookmarks window will display.

t| Create new bookmark |

3. To create the bookmark, selec

The Bookmarks window will update to display the My bookmarks section and the title of the
bookmark will default as the name of the sheet and a summary of the selections made.

Create bookmark x

Title

Bookmark

Description

) 5=veshest location

Savelayout

4.  If needed, update the title of the bookmark in the Title field.
5. Enter a description for the bookmark in the Description field.
To save the bookmark, click anywhere off the Bookmarks window.
The bookmark has now been saved.
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Apply Bookmark Selections
You can apply the selections saved in a bookmark to any sheets and graphs as needed.

1. To commence, open the sheet the selections are to be applied to.

2. Onthe Menu Bar, select ===

The Bookmarks window will display.

Bookmarks Create new bookmark

Q

¥ My bookmarks (1)

PIod 13/84/2618

Fully immunised children (Raw data) - State ("WA')

3.  To apply the bookmark selections, right click on the applicable bookmark and select
Apply selections

The bookmark selections will now be applied to the selected sheet/graph.

PI13: First antenatal care visit
E 20

Show = Jun 2021 Include Trial Submissions Exclwtis Triml Smiiiasions WKP1 definitions and cha.

Maternal and Child Health

Proc are

onth PI13: First antenatal care visit
Age Group PI13
Gestational Age >= Jun 2021 H o
B 1
Gestational Age <= Dec 2020 2 ot

PI13: First antenatal care visit - Comparison ) _ P ——

Comparison Group Limite

o 5 P = -
MMM Rermoteness E E = = £ = s
=R Top 10%
Service Size . =
- Top 253

-

o s

Edit a Bookmark

1. Onthe Menu Bar, select =2

The Bookmarks window will display.

Create new bookmark

Bookmarks

Q

W My bookmarks (1)

PI&4 Fully immunised children (Raw data) - State (WA')

2.  To edit the bookmark, hover your mouse pointer over the bookmark and select i ] on the
right-hand side of the window.

3. To update the bookmark, select .
Update the Title and Description as required.

5. To confirm the changes, select .
The changes have now been made to the bookmark.
6.  To continue working, select anywhere off the window.
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Search for a Bookmark

1.  Inthe Sheets view, on the Menu Bar, select ,

The Bookmarks window will display.

Bookmarks Create new bookmark

Q

¥ My bookmarks (1)

PIe4 Fully immunised childran (Raw data) - State (WA') 13/04/2018

2.  To search for a particular bookmark, enter the title of the bookmark in the Search field.

The Bookmarks list is filtered as you type to display the bookmark(s) that match your search
terms.

Delete a Bookmark

1. In the Sheets view, on the Menu Bar, select .

The Bookmarks window will display.

Bookmarks Create new bookmark

Q

¥ My bookmarks (1)

PI84 Fully immunised children (Raw data) - State ('WA') 13/84/2618

2.  To continue, hover your mouse pointer over the bookmark and select i ] on the right-hand
side of the window.

3. To put the bookmark in edit mode, select .

4, To delete the bookmark, select .

The Delete Bookmark? window will display asking if you wish to delete the bookmark.

Delete bookmark?

The bookmark "P184 Fully immunised children (Raw

data) - State ("WA")' will be deleted.

5.  To confirm deletion of the bookmark, select I

The bookmark has now been deleted.
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Work with Stories

Stories allow you to share your insights into your data with other people. The purpose of stories
is to display data in a story and emphasise elements that are important in your discussions and
decision-making. Adding emphasis will assist you in creating convincing stories to support you
and your stakeholders in decision making.

Stories let you combine reporting, presentation, and exploratory analysis techniques to create
and share for collaboration. You take snapshots of your discovered data for use in stories,
structured by one or more slides. The snapshots can be enhanced with various effects to let you
emphasise the data insights you want your audience to focus on.

As you tell the story and get asked questions, you can switch directly to where the snapshot
came from and get access to the live, updated data.

You can make your presentation even more engaging by inserting live data from Qlik directly
into your slides and selecting them while presenting your story.

Stories are contained within the Health Service nKPI & OSR Report so you can return to live
data at any time. To build a story you use time-based snapshots of your graphs and live data
and place them on the story's timeline. You can add text and shapes to your story, making the
story more engaging.

In Story view you can:

9 Build stories to present insights and ideas based on your data discoveries. You build
stories by using snapshots of your graphs.

1 Play a story as it would be presented to an audience. When you play a story, you can
get access to the graph the snhapshots originated from. If you have embedded graphs
in your story, you can make selections in these graphs just as you can in a graph when
analysing data.
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Create a Story

Once you have taken the required snapshots of your data, you can start to build your story in
your Qlik Health Service nKPI & OSR Report. As part of building your story, you can add
different kinds of visual effects and content such as text, images, shapes, and effects.

The following procedure is used to create a data story in Qlik.

1. From any sheet in your Qlik Health Service nKPI & OSR Report, select Narrate
Storytelling in the middle of the Menu Bar.

The My new story screen will display.

= v @ indigenous Health Dashboard (Ext) (ACC) 2.0 Analyzis story My new sta y @ v

My new story

2.  To create a new story, select in the top right-hand corner of the screen.
The Stories window will display.

Stories Create new story

Create new
story

3.  To create a new story, select in the top right-hand corner of the screen.

The Stories window will update to display the Title and Description fields.

Stories

W My stories (2)

e

Create new story

My new story (1) My new story (2) o

Title

@ My new story (2

Description
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4, Enter a Title and Description for your new story.

5.  Click anywhere outside the text area to save the changes made.

Add New Slides to a Story

Once you have created your story, you can add the required number of slides so you can start
building the story and adding different objects to it as needed.

1. Either select stery from the Menu Bar or & $tories from the Selections Bar and select your
story to open it.

2.  To add the first new slide to your story, select Add slide] iy the top left-hand corner of
the screen.
The new slide has now been added to the story.

3. Repeat step 2 for any additional slides to be added to the story.

& 1o remove a slide from the story, right click on the slide and select Delete.

Add a Snapshotto a Slide

1. Ensure the xxxx (your story name) screen is displayed.

2.  Select the slide to add the snapshot to from the story timeline in the left-hand side of the
screen.

3.  To add a snapshot to your slide, select in the Menu Bar on the right-hand side of the
screen.

The Snapshot library window will display.

Snapshot library

a

4.  To add a particular snapshot to your story, select the snapshot, hold your left (primary)
mouse button down and drag the snapshot onto the story.
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The xxxx (your story name) screen will update to show the selected snapshot now included in
the story.

2

=

PI03: Health assessments - 15-65yrs+ comparison

5.  Once the snapshot is added to the applicable slide in your story, you can move the
snapshot anywhere on the slide by selecting the snapshot, holding the left (primary)
mouse button down and moving the snapshot to the appropriate place on the slide.

6. Toincrease or decrease the size of the snapshot, simply select one of the four green
squares on the snapshot, hold your left (primary) mouse button down and drag the
snapshot in or out as needed.

7. Repeat steps 3 to 6 for any additional snapshots you wish to add to your story.

Add Text to a Story

If needed, you can add explanatory text and titles to snapshots you have added to your story.

1. Ensure the xxxx (your story name) screen is displayed.

2.  Select the slide to add the text to from the story timeline in the left-hand side of the
screen.

3. To add text to a slide in your story, select in the Menu Bar in the top left-hand corner
of the screen.

The Text objects window will display.

Text objects

Title

Paragraph
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To add a title to the slide:
i. Select Title, hold your left (primary) mouse button down and drag it onto the slide.

The xxxx (your story name) screen will update to show the Title text box on the slide.

il

:
i
2

PI63: Health assessments - 15-65yrs+ comparison

ii. Move the Title text box to the desired location as/if required by selecting the text box
and dragging it to its destination.

iii. To add a title to the slide, double click within the text box.
The text box will update to allow the title to be entered.

iv. Enter the title for the slide and use the functions in the toolbar that displays above
the text box to change the colour, bold, italicise or underline the title as required.

To add text to the slide:

i. Select Paragraph , hold your left (primary) mouse button down and drag it onto the
slide.

The xxxx (your story name) screen will update to show the Paragraph text box on the
slide.

= Test Story Title

24 comparison

ii. Move the Paragraph text box to the desired location as/if required by selecting the
text box and dragging it to its destination.

iii. To add text to the slide, double click within the text box.
The text box will update to allow the text to be entered.

iv. Enter the text for the slide and use the functions in the toolbar that displays above
the text box to change the colour and size of the text as required.

v. If needed, you can also bold, italicise or underline the text as well as changing the
justification of the text.
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Add Shapes to a Story

1. Ensure the xxxx (your story name) screen is displayed.
2.  Select the slide to add the shape to from the story timeline in the left-hand side of the
screen.
: :
3. To add a shape to your slide, select 121 in the top left-hand corner of the screen.
The Shapes Library window will display.

Shapes library

HEO

Vmve
AN) <
AR A

4.  Select the shape you would like to add to the slide, hold your left (primary) mouse button
down and drag the shape onto the slide.

The xxxx (your story name) screen will update to show the shape added to the slide.

® v =« Indigenous Health Dashboard (Ext) (ACC) 2.8 Tey

[
I I I I o

5.  Once the shape is added to the applicable slide in your story, you can move it anywhere
on the slide by selecting the shape, holding the left (primary) mouse button down and
moving the shape to the appropriate place on the slide.

6. Toincrease or decrease the size of the shape, simply select one of the four orange circles

on the shape “*. , hold your left (primary) mouse button down and drag the shape in or
out as needed.
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7.  To change the colour of the shape on the slide, select - and select the required
colour from the list.

8. Repeat steps 3 to 7 for any additional shapes you wish to add to your story.

Add Effects to a Story

1. Ensure the xxxx (your story name) screen is displayed.

2.  Select the slide to add the effect to from the story timeline in the left-hand side of the
screen.

3.  To add an effect to your story, select in the top left-hand corner of the screen.

The Effects library window will display.

Effects library

L Highestvalue

Ml lowestvalue

@ Any value

4.  Select the required effect to add to your story. The options are:

9 Highest value - Applying this effect to your story will add a label to the highest value in
the snapshot and will dim the other values.

1 Lowest value - Applying this effect to your story will add a label to the lowest value in
the snapshot and will dim the other values.

1 Anyvalue - Applying this effect to your story will add a value to any manually selected
value in the snapshot and will dim the other values.

5.  Hold the left (primary) mouse button down and move the selected effect onto the
applicable snapshot in the story.

The xxxx (your story name) screen will update to show the impact the selected effect has had
on the snapshot in the story.

@~ =~ IndigenousHealth Dashboard (Ext) Stuart's Story B~ A~ &~
(o]
1 A
Stuart's-fest-Story :
ul :
s
Immunisations timeline (national averages) © < & .
m This is a test story, -

& 2 2 q\\\ﬁ“

) R

S >
oL 3

o o & o

i. To replace the original snapshot in the story with the updated snapshot with the
effect added, select B i, the top right-hand corner of the snapshot.

ay

ii. To editthe new shapshot with the effect added, select 2 inthe top right-hand
corner of the snapshot.
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@ To remove the effect from the story, right click on the snapshot on the slide and select
Remove effect .

Add Media Objects to a Story

1. Ensure the xxxx (your story name) screen is displayed.

2.  Select the slide to add the media object to from the story timeline in the left-hand side of
the screen.

3.  To add an object to your story, select E in the top left-hand corner of the screen.
The Media library window will display.

nnnnn

i. To add an object from within the Health Service nKPI & OSR Report app, select In
app, then select the required object from the list and select .
ii. To add an object from within Qlik, select Default, then select the required object

from the list and select .

The xxxx (your story name) screen will update to show the object added to the slide.

Test - Birthweight

1
[
2
PIe1: Birthweight recorded
Data for collection Dec 2628 improves on the Dec 2628 comparison group average for the selected resul

W My Service
Comparison Group
® Top25%

8

S
o

(75/88)85%(

(r2/90)80% 4

4.  To move the object within the slide, select the object, hold the left (primary) mouse button
down and move the object to the required location.

@ To remove the object from the story, right click on the object and select Delete.
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Add a Data Snapshot to a Story
1. Ensure the xxxx (your story name) screen is displayed.

2.  Select the slide to add the snapshot to from the story timeline in the left-hand side of the
screen.

3. To add a snapshot to your story, select E:
The Select sheet window will display.

Select sheet

(@ When you insert a live data sheet into your 1s of the app are saved with the sheet. Every time you view this sheet in your story, these

¥ Public sheets (47)

Health Summary

Summary

Management

Target #2

PIDT Chronl( DISEE

National Trajectories
g recorded

DAL L DL DL D,

result

Health Service OSR- Summary Client Contacts by nKPI - Client nKPI - Indicators Over NKPI - Recent Results mKF'\VRa;u It Executive Summary
Snapshot Role Summary Time Distribution

Maternal & Preventative

Child Health Health
Maternal and Child Preventative Health Chronic Disease Closing the Gap PIO1L: Birthweight PI02: Birthweight PI03: Health

assessments - 0-14y...

Flos: Health PI05: HbALC recorded

PI06: HbA1c result

se P109: Smoking status P110: Smoking status PI11: Smoking status PI12: Body Mass

Cancel

4,  Select the sheet you wish to add to your story as a snapshot.

@ If you currently have filters applied to the selected sheet, these will appear in the story as
part of the snapshot.

The selected sheet will now be added as a new slide to your story.

P102: Birthweight result

Eb

Live data sheet

202

Active sheet

Pl02: Birthweight result

Alignment

The Live data sheet window displays, allowing you to delete the sheet, select a new sheet or
realign the sheet on the slide as/if needed.
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Work with Items in a Story

Once you have added snapshots, shapes, media objects etc to your story, you can reuse these
items by cutting, copying, and pasting them elsewhere within your story as required. You can
also delete them from the story if needed.

1. Ensure the xxxx (your story name) screen is displayed.

2.  Select the slide the object you are working with is on from the story timeline in the left-
hand side of the screen.

3.  Select the object you are working with.

Test - Birthweight

1
~
il o
2
= Bi i rde
at: improves on the Dec 2826 comparisen group average for the selected result.

B My Service
Comparisan Group
4 Top25%

(75/88) 8554

(12/98)80% 4@
| (78/81) 96% K

There are several tasks that can now be performed with this selected item, at the bottom of the
screen:

i. To cut the item from the slide, select .
ii. To copy the item, select .
iii. To paste the item onto the slide, select EI

iv. To delete the item from the slide, select Ij
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Play a Story

Once you have created your story and have added all the required slides, objects, and text to it,
you can play it to ensure it runs as expected prior to making it available to other users.

1. Ensure the xxxx (your story name) screen is displayed.
2. Ensure the first slide in the story is selected in the story timeline on the left-hand side of
the screen.

3.  To play your story, select at the top of the story timeline.

Your story will now display in slide view.

PIO1: Birthweight recorded

Data for collection Dec 2628 improves on the Dec 2682@ comparison group average for the selected result.

-

W My Service
Comparison Group
* Top25%

(66/66) 100%
(78/76) 160%
(75/88) 85%4

|(7s/s1)aax .
(?‘/74) 9s% K]

I (59/66)89%
(72/90)88% 4

4, To move to the next slide in the story, select ° at the bottom of the screen and select
to move to the next slide in the story.
5. Repeat step 4 for each slide in the story.

6. To close the story once it is finished, select in the top right-hand corner of the screen.

Duplicate a Story

You can duplicate any story in Qlik. This saves you time by allowing you to reuse content and
modify the duplicate to better fit your needs. The duplicated story contains the same content as
the original and is linked to the same snapshots. The duplicated story, however, will not be
updated if the original story is updated.

1. Ensure the xxxx (your story name) screen is displayed.

2. Select - in the top right-hand corner of the screen and select Duplicate story from the
list that displays.

The selected story has now been duplicated
name with a (1) after it. The new story will now display in the xxxx (your story name) screen and
can be worked on as required.
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Delete a Story
If the story is no longer required, it can easily be deleted from the Story screen.
1. Ensure the xxxx (your story name) screen is displayed.

2. Select ... in the top right-hand corner of the screen and select Delete story from the list
that displays.

The Delete story? window will display.

3. To delete the story, select .

The story has now been deleted.

Export a Story to PowerPoint

Once you have developed a story in Qlik, you may wish to export the story from Qlik to
PowerPoint so you can easily deliver presentations without needing access to Qlik.

1. Ensure the xxxx (your story name) screen is displayed.

2.  Select ... in the top right-hand corner of the screen and select Export story to
PowerPoint from the list that displays.

The PowerPoint settings window will display.
. __________________________|

PowerPoint settings

Slide size

Custom -

Width (pixels)

Height (pixels)

781 +
Resolution (dots per inch)
220 ~

1398 x 781 px @ 226 dpi

3. To export your story to PowerPoint, select m

4, To download the content so it can be saved, select Click here to download your
PowerPoint presentation

A pop up will display in the bottom left-hand corner of the screen.

'Eﬂ 3fafB414576c4c22 _pptx = A~

5.  To continue, select -~ in the pop up and select Open.

The presentation will now be opened in PowerPoint and can be saved to your desktop, or
another suitable location as needed.
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Export a Story to PDF

In addition to being able to export your Qlik story as a PowerPoint presentation, you can export
it as a PDF document for later use if needed.

1. Ensure the xxxx (your story name) screen is displayed.

2.  Select ... in the top right-hand corner of the screen and select Export story to PDF  from
the list that displays.

The PDF settings window will display.
-

PDF settings

Paper size

A4(11.7°x8.2757)

Resolution (dots per inch)

268 +

Orientation

Aspect ratio options
Keep current size

Fit to page

3. To export your story as a PDF document, select m

4.  To download the content so it can be saved, select Click here to download your PDF
file.

A pop up will display in the bottom left-hand corner of the screen.

"L f280da65b1854155b. . pdf ~

5. To continue, select #~ in the pop up and select Open.

The PDF document will now be opened and can be saved to your desktop, or another suitable
location as needed.
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Access your Published nKPI and OSR Report s through the
Data Portal

When an Indigenous health data reporting round is complete, you will be able to access your
updated nKPIl and OSR published reports for that reporting round directly through the Health
Data Portal. Once you access your reports, you can save/print/share them as needed.

@ To be able to access your published reports, you need to have been assigned the Published

Report Viewerrole by your health se r v i (dser@aninistrator. 1 f you d ®Repbrts have
> Published reports  option available, please contact your User Administrator so they can

assign you the role. Please note as well that you will only have access to the reports that are

published AFTER you have been given access- you will not be able to see any previous

reports.

1. From the Data Portal home screen, select Reports > Published Reports
The Qlik NewsStand will display.

h * New ~ Reports & Reporting Dashboard

NewsStand Reports Subscriptions 818248968
Reports
Wiew Daterange

All reports v Created v All time v QA

Preview Report Format Quality Created Actions

Yr OSR Summary Over Time XLSX Veryhigh ~ March 16, 2825 3:19 PM

- ﬁ arvice Results Over Time PPTX Veryhigh  March 16, 2625 11:11 AM

3r ﬁ ecutive Summar HLSX Mormal March 16, 262511:11 AM

- ﬁ PPTX Veryhigh  March 16, 2625 11:18 AM

3r ﬁ Health Snapshot PPTX Very high March 16, 2625 11:16 AM

- ﬁ 1(24 months PPTX Veryhigh  March 15, 2825 7:35 PM

@ You will only ever see the reports for the most recently completed reporting round here, you
wonodt see a | i st(exceptfohtiiedNational KRl SUmmaneppesentatisn). This
means you should download and save each report as it becomes available, so you have
ongoing access to each report.
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The OSR Summary Over Time report

Your OSR Summary Over Time report is a Microsoft Excel spreadsheet containing your health

serviceds summary |
contacts, back to June 2019.

evel

OSR dat a, i ncl udi

ng

To download your OSR Summary Over Time report:

1. Atthe top of the NewsStand, you can use the View and Date range fields to filter the

reports that display if needed.

2.  Select the OSR Summary Over Time link in the Report column.

The Save As window will display.

@ saveAs
4 & > UCLPEDGLMS3 » Downloads »
Organize ¥ New folder

UserGuides A Name
Videos
WINDOWS

~ Today (2}

[ UCLPEDGLMS3
[ Desktop
5] Documents
& Downloads

 Yesterday (4)

ional KPI Summary

National kP! Health Service Results Over Time - Service Name - Identified 30-03-2025.pptx.zip
Metro South Health Published Reports

Health Snapshot - 30-03-20255ervice Name - [dentified. pptx zip

v | | Search Downloads L

~ Identified.ppb.

) Music B Nationa
ures

dows (C:)
= Serverfpps (\ce

I KPI Executive Summary - 30-03-2025 - Service Nam
QSR Summary Over Time-30-03-2025-Service Name - I dentified xlsx.zip

entified xlsx zip

Save astype: | ZIP File ("zip)

A Hide Folders

@ Your local download process may be different to what is shown here. If it is, please just

follow your download process as needed.

3. Navigate to where you would like to save the zip file that has been generated.

4.  To save the report, select .

5. Now navigate to where you have saved the zip file and double-click on it to open it.

6. In the zip file window that opens, select the report and select .

The Copy window will display.

Copy

Fles: 1

{9562 B3 bytes )

L5 Users Dunrst CENTRAL \Downlcads'National nkF Health Service Resalts Over Time - Service N
Natiorul rFl Mealth Service Fesults Over Time - Metro South Health 30-03- 20025 ppia

7.  Select l:l and navigate to where you want to save the report and then select E
8. Navigate to where you have saved the report and open it.
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The OSR Summary Over Time report will display, with the Clients sheet defaulted as selected.

Clients

4,680

. IIIIII
2]

'J 3 E ) 5 5 } )

Episodes of Care per Client

® 9 > gt g g
459 w:" A2 A2 er]' B A L

10.8
Measures

W My Service
@ Comparison

S 5°° >¢<\ >°° s\“‘ 5°° 50‘\ 5°°

l

Episodes of Care

48,860

20,000

2]

5\“3

)
.Lzs\ Q‘ m&
S

> ) ) 3 5 3

Nl ] @ ) " %l 13
AN L S UG- (g S %

g

)

Client Contacts
60,000

40,800

20,000

2]

W DA A A

—

The OSR Summary Over Time spreadsheet displays your key Online Services Report (OSR)
information through both graphs and numbers and is broken down into three sheets.

Clients

The Clients sheet (shown above) shows your clients, episodes of care, episodes of care per
client ratio and client contact numbers, in a graphical format, back to June 2019. On the
Episodes of Care per Client graph, you can also see how your ratio compares to other health

services across the country (set by default).

Workforce

OSR Summary Over Time
‘Workforce

Total FTE

68

48

20

2]

Clinical FTE as % of Total FTE
188.8%

) IIIIIII

Q\ Q\ <a <a <a <a @ ,@
R

Measures

MW My Service
® Comparisen

Measures

M My Service
® Comparison

46.6%

Indigenous FTE as % of Total FTE
20.0%
8.0%

68.9%
«m‘ m‘ m‘ v B o

o o
R A 5\*‘\ 5\*‘\ 5\*‘\ s°° 5°°

v

(b\‘

Clinical FTE per 1808 Clients

18

° Measures

MW My Service
® Comparisen

P A CR L
‘\‘Nb(b ‘\‘Q R‘"b‘a c\r@ xrﬁb <\r® <\q"b eri': (\rf«'!
L L

18

2]

The Workforce sheet displays your Total FTE, Indigenous FTE as % of Total FTE, Clinical FTE
as % of Total FTE and Clinical FTE per 1000 Clients in a graphical format.

On the Clinical FTE as % of Total FTE graph, you can also see how your clinical FTE to total
FTE percentage compares to other health services across the country (set by default).
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The National nKPI Health Service Results Over Time  report

The National nKPI Health Service Results Over Time report is a PowerPoint presentation
containing each of the graphs from your detailed individual indicator sheets in the Qlik Health
Service nKPI & OSR Report, for the most recent reporting round.

To download your National nKPI Results Over Time report:

1. Atthe top of the NewsStand, you can use the View and Date range fields to filter the
reports that display if needed.

Select the National nKPI Health Service Results Over Time link in the Report column.

Follow either the download process as detailed earlier in this guide, or your own local file
download process.

4, Navigate to where you have saved the report and open it.
The National nKPI Health Service Results over Time PowerPoint presentation will open.

National nKPI Health Service Results Over Time - Metro South Health 31-05-2022.p... ~ £ Search DUNN, Stuart { | = =} X

File Home Insert Draw Design Transitions Animations Slide Show Review View Help Articulate HPE Content Manager Acrobat & Share 2 Comments|

< X = ELeyout~ A A | A = === U EN\\OocOol s [ L & P Find 0

O 0@ (TReet B AlLogorH 0 g G Replace - G, =
Paste - New Reuse B I LA P A e 3 = — Arange _ Create and Share | Dictate | Design
v : L)% . - = = D e { }ET a 1% Select > Adobe PDF Ideas

Slide v Slides [T Section ~
Clipboard 1% Slides Font Paragraph Drawing Editing Adobe Acrobat Voice | Designer

(1) SECURITY WARNING Macros have been disabled. Enable Content

e el National Key Performance Indicators:

3 Summary Report — Results Over Time

Metro South Health

You can now view/save/print the presentation as needed.
5.  To exit the presentation, simply close PowerPoint.
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The National KPI Executive Summary

The National KPI Executive Summary is a Microsoft Excel spreadsheet containing your health
serviceodos re

sul

t s,

interactive report summary sheets.

for

To download your Executive Summary:

1.
2.

3.

Select the National KPI Executive Summary

each

i ndi

link in the Report column.

cator,
periods. It also contains the results for the comparison groups contained within your Qlik

for

Follow either the download process as detailed earlier in this guide, or your own local file

download process.

Navigate to where you have saved the report and open it.

The Excel spreadsheet containing you nKP/ Executive Summarywill open.

|2 550 Bl

Source: Department of Health nKPi collection.

National Key Performance Indicator Executive Summary

= Result

e 2 ol i A0 AT

Rt

® Ar

= Result not

Collection Date: Dec 2024

Dec 2024 Comparisons
Focus  |Preferred By
nKPI A t Dec2023 | Jun2024 | Dec2024 . By Service
rea outcome My Service National Size: 2501- |By State: Qld “E",mter,"?ss'
Target 5000 Major Cities
of Australia
MATERMNAL AND CHILD HEALTH
PI13-Proportion of Indigenous regular
. e Before 11
clients who had their first antenatal care | = ™ 5% 0% 0% 34% 39% 25% 19%
visit within specified periods
PI01-Proportion of Indigenous babies
born within the previous 12 months whose| /P 84% 74% 82% 77% 82% 72% 79%
birthweight has been recorded
PI03-Proportion of Indigenous regular Age 0-4 yrs
clients with a current completed previous 12 /T\ 18% 14% 17% 22% 37% 38% 45% 43%
Indigenous health assessment months
PI03-Proportion of Indigenous regular Af: 014
clients with & current completed e 1 /T\ 27% 23% 24% 37% 37% 45% 48%
Indigenous health assessment previous
months
PI02-Proportion of Indigenous babies
born within the previous 12 months whose|Low o o o o o
birthweight results were low, normal or birthweight \l/ 13% 10% 4% 12% 12% 10% 9%
high
PI11-Propartion of Indigenous regular
clients who gave birth within the previous Current
12 months with a smoking status of e Js 25% 33% 37% 42% 45% 45% 32%
‘current smoker', "ex-smoker' o 'never
smoked"

You can now view/save/print the report as needed.

4.

To exit the spreadsheet, simply close Excel.
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The National KPI Summary Presentation

The National KPI Summary Presentation is a PowerPoint presentation containing each of the
graphs from the summary sheets in the Qlik Health Service nKPI & OSR Report, for the most
recent reporting round.

To download your National KPI Summary Presentation:

1. Atthe top of the NewsStand, you can use the View and Date range fields to filter the
reports that display if needed.

Select the National KPI Summary Presentation  link in the Report column.

Follow either the download process as detailed earlier in this guide, or your own local file
download process.

4, Navigate to where you have saved the report and open it.

The PowerPoint containing your nKP/ Summary Presentationwill open.

National Key Performance
Indicator Summary Report

You can now view/save/print the presentation as needed.
5.  To exit the presentation, simply close PowerPoint.

@ In addition to your current National KPI Summary presentation, you will also see your four
most recent historical National KPI Summary presentations, available for download as needed.
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The Health Snapshot presentation

The Health Snapshot is a PowerPoint version of the Health Service Snapshot you can find in
your Qlik Health Service nKPI &0OSR Report.

To download your Health Snapshot presentation:

1.  Atthe top of the NewsStand, you can use the View and Date range fields to filter the

reports that display if needed.
Select the Health Snapshot link in the Report column.

Follow either the download process as detailed earlier in this guide, or your own local file
download process.

4, Navigate to where you have saved the report and open it.

The PowerPoint containing your Health Snapshotwill open.

T Health Snapshot - 30-03-2025Metro South Health ppix « Saved to this PC v

ations ~ Slide Show Record Review View Help Ariculate  Acrobat

AENNOoO[ | Pa |
AL LD 0 G[%| amm
exNA Y] | ~

Paragraph Drawing

ge

Health Service Snapshot e e

OSR Data: 2024

,,,,,

T - B [
—— | I
— ]
». ]
=] e

You can now view/save/print the presentation as needed.

5.  To exit the presentation, simply close PowerPoint.
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Specific Sheets in the Qlik Health Service nKPl & OSR Report

In your Health Service nKPI & OSR Report in Qlik, there are several summary and detailed
sheets that you can use to analyse your Health-related data. These sheets are all accessible
through the Health Service nKPI & OSR Report screen.

This section of the user guide details the different types of sheets (both summary and detailed)
available in Qlik and the information included in these sheets.

The Health Service Snapshot

Health Service Snapshot
'

3439 3348 45401 32,843

Service Summary Wark Force FTE (key roles) - Jun 2824

40,483

The Health Service Snapshot sheet allows you to view key summary nKPI and OSR information
for your health service.

)l

Summary Info 1 is located next to the map and shows information related to your
servicebds |l ocation, including the number of
category and your socio-economic IRSEO index number.

Service Name field 1 If you have multiple delivery sites, you can use this field to select
the site you wish to view the snapshot for.

Indigenous Client Population 1 Jun 2025 demography graph 1 shows the gender
breakdown (in numbers) for your Indigenous population, by age group, for the most
recently completed collection period.

Service Summary table 1 shows key summary information for your service for the three
most recently completed collection periods, such as your client numbers, episodes of
care and FTE numbers. The table also contains a Trend column, which shows how you
are trending for each of these elements.

Indigenous Client 715 Health Assessments graph T plots the number of health
assessments your service has conducted, by age group, back to December 2014. The
information displayed here can be filtered by age group, Indigenous status, and gender
using the buttons above the graph.

Work Force FTE (key roles) 1 Jun 2025 table i shows your FTE numbers for key
position types, for the most recently completed collection period.

Targets graph 1 shows your self-determined targets for the applicable nKPI&, along
with your actual results and the national average for each of these indicators/focus
areas, for the latest collection period.
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The Summary Over Time sheet

Clients Episodes of Care

2000 20,690 - - - = = Comparison Organisation:
6 s & =
1229 1309 z - b
Comparison Group
ASGS Remotencss
R K b O > J > e o @ - 3 g - 4

MMM Rematanass
Indigenous Region
Service Size

Episodes of Care per Client Client Contacts
state

oy Servce
v > o
IIIII IIII - .- ? : I |

The Summary Over Time sheet displays your key Online Services Report (OSR) information
through both graphs and numbers, and is broken down into three sections

GPs (FTE)

Nurses (FTE)

Clients & Clinical Activity

This section (shown above) shows your clients, episodes of care, episodes of care per client
ratio and client contact numbers, in a graphical format, back to June 2016. On the Episodes of
Care per Client graph, you can also see how your ratio compares to other health services
across the country (set by default) or health services in a comparison group you can set up
yourself using the Comparison Group section.

Total FTE (Paid+Unpaid) Indigenous FTE as % of Total FTE
! o : . » W MySenice
T o & e = : ] 2 compares
T T 8K - s g
sae 4 = i Comparison Organisation
281 a0 a e
oe . . l l I I I I . Comparison Group
¢ & @ ) & g U & R . J o ASGS Remoteness
MMM Remoteness
Sarvica Sizs
Clinical FTE as % of Total FTE Clinical FTE per 1888 Clients
. state
e = My Service ’ W My Service
w2 Comparison Comparis aps(FTE)
] : 8 o ° & o o @ N . Nurses (FTE)
o = = i E & 2 : e 150 » N
120 — 88 13 AHWs (FTE)
% [ ] :
niENln
GP FTE per 1008 Clients Nurse FTE per 1608 Clients
- W MySenvice ’ @ W My Senvice

This section displays your Total FTE, Indigenous FTE as % of Total FTE, Clinical FTE as % of
Total FTE, Clinical FTE per 1000 Clients, GP FTE per 1000 Clients and Nurse FTE per 1000
Clients in a graphical format.

In each of the graphs (except for Total FTE) you can also see how your data compares to other
health services across the country (set by default) or health services in a comparison group you
can set up yourself using the Comparison Group section.
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Data

Service Summary
FTE includes employees paid and unpaid by a service
My Service-Jun Comparison Group - Jun
. vae Ry service - Jun 2019 2020  MyService-Jun2021 My Service-Jun2822 My Service- Jun 2023 My Service - Jun 2624 My Service - Jun 2025 2025
Clients 1613 2233 2012 2372 2,807 2,022 2618 -
Indigenous Clients 1,366 1,825 1,668 1,853 1,693 1730 2323 -
Indig. Regular Clients (nKPI) - = 1,500 1,501 1,693 1714 2410 -
Indigenous Clients ¥ of Total Client: 847% 817% 828% 781% 84.4% 85.6% 887% 817%
Non-Indigenous C| 285 386 242 422 276 257 267 -
Client Contacts 19,588 19371 25,845 28858 29,887 63,588 28272 -
Episodes of Care 13,827 16,395 20,683 21,197 10,239 17,669 18,029 -
Contacts per Client 12 9 12 12 15 31 11 12
EQC per Client 86 73 1e.2 89 9.6 87 6.9 81
FTE (Paid+Unpaid) 43.2 473 737 55.8 59.4 62.3 513 445
Indigenous FTE (Paid+Unpaid) 183 261 374 276 36.4 32.2 216 -
Indigenous Paid FTE 183 261 374 276 30.4 322 216 -
Indigenous FTE as % of Total FTE 42.4% 55.6% 50.7% 50.2% 51.2% 51.7% 421% 44.6%
Clinical FTE (Paid+Unpaid) 19.4 19.8 25.9 256 216 241 201 -
Clinical FTE as % of Total FTE 44.9% 40.1% 352% 46.5% 36.4% 387% 38.2% 63.8%
Clinical FTE (Paid+Unpaid) per 1808 128 8.5 12.9 10.8 10.8 119 77 153
GP FTE per 16 18 13 22 13 14 1e a8 12
Nurse FTE per 18 s 21 13 15 17 24 19 15 1
Admin FTE (Paid+Unpaid) 238 284 478 294 378 382 312 -
Admin FTE as % of Total FTE 55.1% 58.9% 64.8% 53.5% 63.6% 613% 68.8% 370%

The Service Summary table in the Data section at the bottom of the sheet allows you to see
your key OSR summary information (such as client numbers, episodes of care and FTE
numbers) for all collection periods, back to June 2019.

It also contains a comparison group column, which allows you to display data for the most
recent collection period, for the comparison group of your choice, created using the Comparison
Group section on the right-hand side of the sheet.
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The Client Contacts by Workforce Role sheet

OSR Reporting Round
Client Contacts by Workforce Role

Profession Type Qi | Profession Cate... Q OSRReporting R... &

Client Contacts 19,508 19,371 25845 28,058 29,807 63,500 28272
General/ other staff 1,690 - 1206 814 1712 1712 048
1,608 - 1208 814 17112 1712 ads

1424 - 648 - 1712

13,536 13,487 18,645 20,986 22,788 45,302 22,401
ss6 678 2150 1,147 1,040 784 1,008

586 674 684 1,688
1,638 458 114 138 233 4113 108
° - 50 38 1358 5

ssssssssssssssssss

Do actitioner 2113 0,877 18,644 18371 8388 17184 12667

The Client Contacts by Workforce Role sheet allows you to analyse the client contacts your
service has had each year (back to June 2019) as reported in your OSR. The table defaults to
display your total client contacts for each year and then breaks the contracts down by
profession type, profession category and then individual profession.

You can filter your client contacts by profession type, category or profession if needed, using

Profession Q

the filter fields at the top of the sheet

You can also filter your client contacts by year using the | SR ReportingRound__| 1\,tt07 4t the top
of the sheet.
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The nKPI 1 Indicators Over Time sheet

Remove Indicator +

Plo1

PI02 Norma

Pi02 Low

Pios o-1ayrs

Plo3 15-24yrs

Plo3 25-54yrs

PIO3 55+yrs

PI0S 12 months

PI0S 6 months

PIos HBALC

Add Indleators

Pio

Pio2 Normal

Plo2 Low

Plos o-1ayrs

Plos 15 24yrs

Ploz 25 sayrs

PI03 554yms

PIOS 12 months

PI0S 6 manths

Where no values are shown in the table, the indicator specifications have been updated
from the previous reporting round. For simplicity, the table only displays indicator values
after the specification update. Historical data from before the updates are available in the
respective detalled indicator Qlik reports.

nKPI Results by Reporting Round

Values nKPIReporting... Q

EEY
56%

sax 40K € 4 4
7% enx o @ 8 %
76% 60% %
B6% a %

DIBA- BnATe roculr

Result Improved / Recul

it Not Improved

843
8ax %
1%
ELERNN
5%

LR

& 3%

nKP!I - Indicators Over Time

et b ol i, o i i b

Add Indicator + Remove Indicator +
Pi1s Before 11 weeks... [T NUR TN
P4
Pie
(TR | Piis Type 2 Disbetes
Pi1sOVD Pl1s (VD
Pi16 CVD and Type 2 Dic| [ ICTalEERR PRI
P19 T2D High Risk P119 T2D High Risk
PI19 CVD High Risk P13 VD High Risk
Pi19 T2 sndfor VD i JRCTCRETRSRTGYS
R0
[
P12 HPY test onty PI22 HPV test anly

P23

s

B

s

3 =l z
H

The nKPI i Indicators over Time sheet contains the Aggregated nKPI Results by Reporting
Round table, which displays your results for all indicators/focus areas for all nKPI collection
periods, back to June 2017. Where your results for an indicator/focus area are improving, the
values will display in green. Where your results are getting worse over time, they will display in

red.

@Where

indicator prior to the specification change occurring.

1. To

button (e.qg., |

remoyve

t her e

has been

an indi

PIg1

a

c hangeil willdispynforthatd i cat or 6

|) in the Remove Indicator column.

catorods/ focus

areads
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The nKPI T Service Targets and Reported Values sheet

---------- Result Impraved / Result Not Improved

Targets and Reported Values by Service and Reporting Round

Serviee C || Target Q|| Reporting Round Q.

The nKPI i Service Targets and Reported Values sheet will display your self-determined target
values for the nominated indicators/focus areas (P103, 05, 14, 18 and 23) as entered in the nKPI
Targets tab of your nKPI form, from June 2023 to December 2027.

The sheet will also show your actual reported values for each of the indicators and whether they
have reached your self-determined target for that indicator/focus area, for that period. If the so,
the percentage will be in green, if not it will be in red.

@ The filter fields above the table can be used to filter the results by indicator and/or reporting
round as needed.
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The Executive Summary sheet

Executive Summary
Latest Round Custom: Service Size Custom: State Custom: ASGS Re... ‘_’ '.’ “ pe 70 decimal piscee. The: 9ie determinet o

Show Percentages. IR Result Improved / Result Not Improved

Maternal and Child Health

The Executive Summary sheet of the Qlik Health Service nKPI & OSR Report allows you to see

your health serviceds results for the t hifoug most
area by indicator grouping. It also shows how your results compare to the results of the pre-

determined comparison groups sourced from the nKPI Summary sheets.

The following are the key elements of the Executive Summary sheet:

i Latest Round filter field i allows you to change the nKPI collection periods being
displayed in the table, so you can display historical data if needed.

1 Custom filter fields i allow you to build your own customised comparison group for
which your results will then display in the Comparison groupsection of the table.

9 Indicator and nKPI columns i describe each of the indicators/focus areas included in
the specified grouping.

1 The Focus Area columni where applicable, displays the focus area for the indicator
(for example Low birthweight for P102 or Current smoker for P110).

1 The Preferred Outcome columni informs you whether the desired result for the
indicator is for a higher or lower result

1 Collection period columnsi s hows your health servicebs res
collection periods for each of the indicators/focus areas in the specified grouping.

o Ifaresultis better than the corresponding result for the previous period, the
result will display in green.

o Ifaresultis worsethan the corresponding result for the previous period, the
result will display in red.

i The My Service Targetcolumn 71 showsyoursel ect ed heal-th service
determined target for the most recent collection period, for the applicable
indicators/focus areas.

1 Comparison group columnsi shows the results for the most recently completed
collection period for the comparison groups shown in the nKP/ Summary sheets and the
customised comparison group, that can be set using the custom filter fields at the top of
the sheet.
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The nKPI Summary sheets

Qlik contains the following three summary indicator sheets:
1 Maternal and Child Health Summary
1 Preventative Health Summary

1 Chronic Disease Management Summary.

Maternal and Child Health Summary

Process of Care

(1) PI13: First antenatal care visit Dec 2025 (1) PI81: Birthweight recorded Dec 2825 (1) PI83: Health assessments - 8-14yrs Dec 2025
Before 11 wks Birtrweigit recorded » 1 vis

Outcome

(1) P102; Birthweight result > 1 visit Dec 2025 (1) PI11: Smoking status - new mothers Dec 2025

In the three nKPI Summary sheets in the Qlik Health Service nKPI & OSR Report, the indicators
are grouped by Process of care (top half of the screen) and Outcome (bottom half of the
screen). Process of care indicators focus on the extent to which eligible clients have received a
particular test or screening or have had specific information recorded in their records (e.g., PI01
Birthweight recorded). Outcome indicators reflect the prevalence of specific health conditions or
health behaviours among the clients of an organisation. Health outcomes are affected by many
factors and should not be the direct result of the process-of-care indicators (e.g., PI02

Birthweight results).

There is at least one graph for each indicator in each of the summary sheets but, for some
indicators, there may be more than one.

(1) P183: Health assessments - 8-14yrs Dec 2025

Major Cities of Australia

Previous Period (Jun
2825)

Each of the nKPI Summary sheets display the following information as bars in the graph (from
left to right):
1 National results (orange bar)
1 Results for services with the same number of clients as your service (grey)
T Your ser viforehé surrenteorsmodt tecent collection period (dark blue)
9 Your results for the same indicator for the previous period (shown as a light blue dot on
the graph for your serviceds current results)

1 The results for all services in your state (green)
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1 The results for all services with the same remoteness as your service (brown).

If the arrow to the left of the title of the indicator/graph you are looking at is pointing up, this
means that a higher result/percentage is the preferred outcome. If the arrow is pointing down ,
this means that a lower result/percentage is preferred.

Other functions available on each of the nKPI summary sheets are:

q | mysenicepatammort | _ pjoe you to export your health service data for each of the

indicators contained within the sheet, to Excel.

q | 2 comparison group dat... |-AI l ows you to export yofareactcobmpari s

the indicators contained within the sheet, to Excel.

1 - Takes you to the detailed individual indicator sheet for the selected graph. This
button appears underneath each graph in each nKPI Summary sheet.

& The Maternal and Child Health Summary sheet is shown in the screenshot above, but the
same elements are also contained within the Preventative Health and Chronic Disease
Management Summary sheets.
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The Closing the Gap Target #2 Sheet

Target u2:

GPs (FTE)

Nurses (FTE)

Dac 2031

rmal
e e e T R )
== = = e
‘ || 5:.

The Closing the Gap Target #2 sheet shows your results for the Normal birthweight band of
P102 (as the blue bars) and how these results compare to the Closing the Gap target that has
been set to be 91% by 2031 and displays as =.

In addition to showing your results and the Closing the Gap target line, the orange comparison
group line will also display in the graph. By default, this line will represent the national
average for P102 Normal birthweight.

If needed, you can create your own customised comparison group using the Comparison Group
section on the left-hand side of the sheet. The comparison group line will then update to
reflect the results of your selected comparison group.

In addition to the Closing the Gap Target #2 1 Normal Birthweight (P102) I Progress Against
Target to 2031 graph, a data export table will also display.

Jun 2871

The Closing the Gap Data Export Table shows the applicable data collection months, your
heal t h 102 Normal birtheeight results for each collection period, the corresponding
results for your selected comparison group, and the Closing the Gap Target percentage for
each collection period, out until December 2031.

If needed, you can export the data from the table to Microsoft Excel by right-clicking on the
table, selecting Export and then Export data . You can then click on the link to that displays to
download the Excel spreadsheet, which you can then filter and save as needed.
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The Individual Indicator Sheets i Overview

PI01: Birthweight recorded
Show =Dec 2020 ow = Jun 2021 Anitions and o

Maternal and Child Health

Include Trisl Submissions Exclude Trial Submissions ] I aKPi definitions and ch

(52/64)96%
P181 Compar. Orgs - Dec 2625| o 36/500 725
MMM ess
s: s:
stat
P (FTE)

9
‘Comparison Group Limi
Tops %

There are 23 individual indicator sheets in Qlik for the 22 indicators currently reported on by
health services through the Health Data Portal. There are common elements contained within
each of these sheets, as indicated by the highlighted sections in the above screenshot.

These elements are explained below:

1.

Sheet Title T The title of each individual indicator sheet displays in the title bar at the top
of the sheet.

i H . Show = Jun 2628 Sh = Dec 2828
Time Series toggle buttons ow = Dee |

- Allow you to choose whether you view your data for before or after the specification
changes were made to the applicable indicators for either the December 2020 or June
2021 collection periods. Please be aware that if you select either

| Show Dec 2626 | or _you will only see one or

two bars.

Include/Exclude Trial Submission toggle e swmissions |
Allows you to switch the display of trial submission data on and off in the graphs contained
within each individual indicator sheet. For more information see Displaying Trial
Submission Data later in this section of the user guide.

nKPI Definitions and change history button [TEET— Y selected,

this button will take you to a sheet that lists the definition for each of the indicators. For
those indicators that have hade specification changes made to them, it also summarises
what these changes are.

Collection Month

Filter fields | - Allows you to filter the results displayed in the
graph/graphs on the sheet by certain characteristics, such as Collection Month or Service
Mode. When a selection is made through a filter field, this selection will appear in the grey
Filter Bar at the top of the sheet. For more information, see Working with Filters later in
this section of the user guide.

Comparison Group section i Allows you to create a comparison group of your choice
(e.g., all services from the same state) to compare your results against for the selected
indicator. This section will either display in the bottom left-hand corner of the sheet, or in
the bottom half of the sheet, depending on which indicator you are working with. For more
information, see the Working with Comparison Groups section later in this user guide.

Main window 1 This is where the applicable graph/graphs displaying your health
servicebs results for ®écémberalid, forche $eleated per i od s
indicator will display. Trial submissions will be identified by a T in front of the month in the

bottom axis. Draft submissions will be identified by a D in front of the applicable month in

vl.5
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the bottom axis. More information regarding what displays in this window is provided in
the detailed descriptions of each individual indicator sheet later in this guide.

8.  Export buttons ¢ My Sericepatatsport | | e Comparioncrouppat... | _ pjjouy you to export your

results, and those of a selected comparison group, for the selected indicator to an Excel
spreadsheet for analysis as needed.

Top5 %

Topl8 %

Top25%

9.  Comparison Group L imiter - Allows you to display the top 5, 10 or
25% of services contained within the selected comparison group. For more information,
see the Comparison Group Limiters section later in this user guide.
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Display Trial Submission Data

If you wish to track your data trends over time in your individual indicator sheets in the Qlik
Health Service nKPI & OSR Report, you can do this using the Trial Submission option in the
Data Asset Details screen when submitting your data through the Data Portal.

For example, if you wish to track your data month by month, you can submit trial data in the
Data Portal each month using the normal submission process (direct load or manual
submission) and then view this data in each of your individual indicator sheets in Qlik.

@ It is important to note that your trial submission data will not appear in any nKPI summary
sheets in Qlik T it will only appear in the detailed individual indicator sheets.

Once entered through the Data Portal, your trial submission data will appear in all detailed
individual indicator sheets in your Qlik Health Service nKPI & OSR Report.

5B

PI81: Birthweight recorded

2
o
- .
=

(55/6R)B1X
(57/6E)BA%

2t
@

[72/78) 92%
(7877 4y 98K
(B5/73)95%
[84/89) 83%
[124/192)87%
(82/78) 89X

The individual indicator sheets show how your healthser vi ceds results are
collection period, back to December 2014 for the selected indicator.

If you have submitted trial data through the Data Portal for a particular indicator, then this trial
data will appear (identified with a T at the beginning of the month label on the bottom axis of the
sheet) in the graph for the applicable month(s).

While your trial submission data will appear in the graphs by default, it can be removed by
selecting the Exclude trial submissions toggle in the top right-hand corner of the sheet
(highlighted in the above screenshot).
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Breaks in Time Series

Prior to the January and July 2021 and the January 2022 nKPI reporting rounds in the Health
Data Portal, specification changes were made to some of the indicators being reported on.

The following indicators had changes made to them for the January 2021 reporting round:
9 PIO3: Health assessments 0 -14 1 age group change from 0-4 to 0-14 years

1 PIO3: Health assessments 15 -65yrs+ - addition of the 15-24, 55-64 and 65 year and
over age groups.

1 PI14: Immunised against Influenza 1 age groups included changed from 50+ to 6
months +

1 PI22: Cervical screening T The 65-69yr and 70-74yr age groups were combined to
form the 651 74yr age group and the 2, 3 and 5 year break down was removed.

The following indicators had changes made to them for the July 2021 reporting round:

1 PIO1: Birthweight recorded 1 the definition of the indicator changed to only record the
birthweight for those babies who had more than one visit to the service

1 PIO02: Birthweight result - the definition of the indicator changed to only record the
birthweight result for those babies who had more than one visit to the service

P109: Smoking status recorded i the 11-14 age group was added
P110: Smoking status result - the 11-14 age group was added

P111: Smoking status new mothers 1 the 157 19, 20-24 and 25-34 age groups were
changed to less20yr and 20-34yr.

The following indicators had changes made to them for the January 2022 reporting round:

1 PI12: Body Mass Index - the underweight, normal weight and not calculated
categories were added and the inclusion age was lowered from 25 and over to 18 and
over.

9 PI18: Kidney Function Test recorded 1 The 0-14 year age group was added and
eGFR and ACR reporting was changedto6 b ot h, 6toenet ot @enseti & h Also, t est 6
aneiét her caagonbwag added to countthe number of clients with any of the
included conditions.

The following indicators have had changes made to them for the July 2022 reporting round:

9 PI18: Kidney Function Test recorded T The 0-14 year age group that was added for
January 2022 reporting has been removed, and the 1571 24 year age group has been
changed back to 18 i 24 years.

1 PI19: Kidney function result categories i The Severe and Indeterminate risk
categories have been removed from the indicator.

The data for these indicators before and after the changes ¢ a ndidettly be compared in the Qlik
Health Service nKPI & OSR Report so, to resolve this, the Show < Jun 2020, Show > Dec
2020, Show < Dec 2020, Show > Jun 2021, Show < Jun 2021 and Show > Dec 2021 buttons
were added to the top of each of the applicable individual indicator sheets as needed (as
highlighted in red below).
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These buttons allow you to choose which time periods you wish to view your data for in the
applicable sheet.

PI01: Birthweight recorded
Show < Dec2020

Maternal and Child Health
Process of Care

Callection Montn PI1: Birthweight recorded >1 visit

Include Trial Submissions Exclude Trial Submissions P! definiions and cha...
PIB1 Compa
Comparison Grou omparison Gro pL niter
ASGS Remotan Don' mmay
MMM Rematenes: Top 5%
Service Size
op 25

PI13: First antenatal care visit
Maternal and Child Health Show £ Dec 2020 | Showzswezm | Exchue Trisl Submissions K1 definitians and cha...
car tor : &

PI13: First antenatal c

:
n

ws A P113: First antenatal care visit - Comparison (4 Comparisan Group data

Comparison Group Limiter

o
ASGS Remotaness Don't Display
o To be displayed the comparison group must have more tha

5 arganisations and a single gestational age group must be selected op 5

Top 10

Top25

When your data displays in the individual indicator sheets in Qlik, it shows all your health
serviceds results for the s eériedc(aneidcludinguial cat or
submissions if applicable) back to December 2014. There may be times, however, when you

dondét want t o s e eheathslyouwishuto focdsan aapariicular ¢olfeetion period,
for example.

If this is the case, you can use the Filter fields available on the left-hand side of the screen to
change the data that displays in the graph. The Filter fields available in each sheet will differ
depending on the indicator. Some indicator sheets will only allow you to filter your results by
Collection Month while others will give you additional options.

To apply a filter to your results in an individual indicator sheet:
i. Select the applicable Filter field.
The Filter window will display.
ii. Selectthe option you wish to filter the data by.
iii. To continue, select M.
The filter has now been applied to the graph in the sheet.

@ To remove the filter and return the graph to its original view, select & on the
selection in the grey Filter bar at the top of the sheet.
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Export Sheet Data

PI01: Birthweight recorded
ncte oot sobmisions | T kP! definitions spd ch.
P181: Birthweight recorded > 1 visit

I I I I I I I I =S
Tops

When working with your data in the various individual indicator sheets in Qlik, you may wish to
export your data out of Qlik so you can share it with members of your healthse r vi c e
have access to the Health Data Portal and Qlik. Alternatively, you may wish to export your data
into Excel so you can work with it in other applications as required.

Maternal and Child Health Show 3 Dec 2020 Show = Jun 2021

Process of Care

nnnnnnnnnnnnnn

wh o

dor

The export function in Qlik will allow to export either your healthse r vi c e 6 srtheressilis| t s o

of your selected comparison group/the national data set.

@ When exporting data from Qlik, you can export it as a .png, a PDF or an Excel spreadsheet.
In this section, we focus on exporting your data to an Excel spreadsheet.

To export data from an individual indicator sheet in Qlik:

i. Apply any filters/Comparison Groups to your results as needed to ensure the
required data is displayed in the graph.

ect

ii. Tocommence the export of your healthser vi cebs results, sel
| % My Service Data Export
iii.h. To commence the export of your Comparison G

| ¢ Comparison Group Dat... |

The applicable Data Export screen will display.

iv. To continue, right click anywhere on the Data Export table and select Export from
the menu that displays.

v. Select Export data .
The Export complete window will display.
link.

vii. In the pop up that appears at the bottom of the screen, select Save > Save as.

vi. Select the Click here to download your data file

The Save as window will display.
viii. Navigate to the location you wish to save the spreadsheet to and then select

Save

You can now analyse/manipulate the data in the spreadsheet as required.
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Work with Comparison Groups

As mentioned above, comparison groups allow you to build a customised group of health
services to compare your own results to for certain indicators. For example, you may wish to
compare your results for an indicator to the results of other health services of the same
remoteness category with a similar number of clients.

The Comparison Group/Comparison View section of the individual indicator sheets in Qlik will
appear differently, depending on the individual indicator sheet you are working in.

Single Dimension Indicators

Vaternal and Child Health FEr N, e Tr— ErTTTe—s
Colkection Month PI81: Birthweight recorded >1 visit

Comparison Group Limiter|
Tops
Tep 1
Top25%

For those indicators with a single dimension (e.g., PIO1: Birthweight recorded) one bar chart is
used to display both your healthser vi ceés results over tithme and co
national average or other organisations.

GPs (FTE)

The Comparison Group section will appear in the bottom left-hand corner of the sheet
(highlighted above) and the results for the current comparison group (will default to the national
average if no comparison group is selected) will appear in the graph as orange lines ( ).

Health services can use the selection options in the Comparison Group section in the bottom
left-hand corner of the sheet to build the desired comparison group. The graph will then update
to display the results for the selected comparison group.

Indicators with Multiple Result Bands

Maternal and Child Health Show % Dec 2020 [ Sewranzom | Include Trial Subrmissions kP defnitions and ch.

Process of care

P " PI13: First antenatal care visit
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PI13: First antenatal care visit - Comparison

For those indicators which contain multiple results bands (for example, Low, Normal and High
birthweight results) two bar charts will be showni n t h e isheeti Theatdp chard displays
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all result bands for your health service while the bottom chart will be blank to begin with but will
display comparison data when a single result band is selected in the top half of the screen.

Once a result band is selected, the Comparison View in the bottom half of the screen will
update to display the national averages for the selected results band.

You can then create a comparison group for the selected indicator using the selection options in
the Comparison Group section in the bottom left-hand corner of the sheet. The graph in the
Comparison View section will then update to display the results for the selected comparison

group.

Create a Comparison Group
To create a comparison group in this type of individual indicator sheet:
i. Inthe Comparison Group section, select the applicable filter field for the first option
to be added to your comparison group.

Wt you wish to see more selection options for the building of your comparison group,

select | . The additional options that will display are Nurses
(FTE), AHWs (FTE) and Organisation Type.

ii. Selectthe applicable option and then select 4 to confirm.

iii. Make any further selections as required.
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